The Aglets 2.0.2 User’s Manual

Luca Ferrari

October 6, 2004
Contents

Introduction 3

1 Installation 5
  1.1 Installing from compiled packages .......................... 5
  1.2 Installing from the CVS .................................. 10
  1.3 Compile from the source .................................. 11

2 Managing login data 13
  2.0.1 Creating a new account .................................. 13
  2.0.2 Changing the password of an existing account ........... 14
  2.0.3 Deleting an account .................................... 15
  2.0.4 Listing the content of the keystore ...................... 15
  2.0.5 User’s Configuration Files ............................. 16

3 Using the Tahiti server 17
  3.1 Tahiti GUI .................................................... 17
    3.1.1 The Aglet menu ...................................... 17
    3.1.2 The Mobility menu ................................... 21
    3.1.3 The View menu ....................................... 24
    3.1.4 The Options menu ................................... 25
    3.1.5 The Tools menu ....................................... 29
    3.1.6 The Help menu ....................................... 31
  3.2 The Tahiti command line .................................. 31

4 Developing agents with Aglets 33
  4.1 Configuring your IDE to use the Aglets library ............. 33
    4.1.1 Using command line tools ............................. 33
    4.1.2 Using IBM Eclipse .................................... 34
    4.1.3 Using Netbeans IDE ................................... 36
    4.1.4 Using JBuilder ........................................ 36
  4.2 Base Knowledge ............................................ 37
    4.2.1 Main Methods of an Aglet ............................. 37
    4.2.2 Message handling ..................................... 38
    4.2.3 Events ................................................ 39
4.3 Code Examples .............................................. 39
   4.3.1 A base agent ........................................ 40
   4.3.2 Event Listeners .................................... 40
   4.3.3 Remote Messaging ................................. 43
   4.3.4 A sleeping aglet ................................. 45

5 FAQ & Configuration Files ................................. 48
   5.1 FAQ .................................................. 48
   5.2 Configuration Files ................................ 64

6 The IBM Public License - version 1.0 .................... 68
Introduction

This document provides a guideline for those, either developers or users, who want to deal with the Aglets mobile agent platform.

Originally developed at the IBM Tokyo Research Laboratory, Aglets was appreciated for its clear and easy to use API, good modularity and design. Since the initial effort of IBM, several versions of Aglets have been released, and currently the project is hosted at Sourceforge. The development was stopped around 2001, and now it is going to restart due to the change of the project administrator.

Due to several reasons, there is not a complete documentation about Aglets, thus the reason of this document. Furthermore, most of the documentation available in Internet is quite old and does not reflect the real platform behavior. This manual wants to substitute and concentrate most of the old documentation, being “the entry point” for everyone who wants to start using Aglets. Of course, as the platform itself, this manual is always under construction, thus you should check periodically for newer versions. Furthermore, since describing Aglets is not a trivial task, due to its extension, I preferred to start writing what really lack in the documentation: how to install, how to write sample aglets, how to manage server data, etc. I hope this manual will, one day, substitute all other documents available, but the fact is that it does not do today, and in fact you will not find here information about concepts like proxies, messages, etc. This means that, before you start developing agents, you have to look to the Aglets Working Draft (still unfinished), just to learn base concepts about activation/deactivation, message passing, etc.

On-line Resources

There is not a lot of documentation and examples available on-line, and furthermore they are often quite old. It is for this reason that I have decided to write this guide. However, if you need further help, you should take a look at the Aglets web site: http://aglets.sourceforge.net. There you can find information and documentation about the Aglets project, and of course about the Aglets mailing lists. So far, Aglets provides four mailing lists:

- aglets-users:
a general mailing list for users and developers who use the Aglets technology;

- **aglets-developers:**
  a mailing lists for all who are involved in the Aglets platform development, want to propose new features or to submit bugs;

- **aglets-commit:**
  informs about the CVS commits and new available releases;

- **aglets-net:**
  a mailing list related to the *aglets-net* project, a collection of Aglets-based applications.

Actually, mailing lists are the fastest and easiest way to get help about Aglets. At time of writing, the Aglets website is under construction, thus it could appear uncomplete; I am doing all my best to complete it.

**About this document**

The original version of this document has been written by Luca Ferrari using \LaTeX{} on a Linux system. People who wants to collaborate to improve this document (correcting mistakes, adding images or code samples, etc.) can contact me at cat4hire@users.sourceforge.net or can post a message to the aglets-developers mailing list.
Chapter 1

Installation

This chapter describes how to install and run for the first time the Aglets 2 platform. Please consider that Aglets 2 is shipped with both the ASDK (Aglets Source Development Kit) and the run-time environment. The former is the Aglets library, that allows developers to compile Aglets-based applications; the latter is a set of pre-built agents and programs used to implement a stand-alone platform, thanks to which you can execute and dispatch agents on your machine.

To run the Aglets platform you need at least a Java 2 Run-time Environment (JRE), even if it is recommended to install the full Java 2 Source Development Kit (J2SDK), which allows you to compile agents. This chapter does not cover how to get and install the JRE or the J2SDK; for information about Java see the SUN web site: http://java.sun.com. Aglets can be installed on a Unix/Linux system, Microsoft Windows and Mac OS X. More in general, each architecture able to run the Java 2 platform is a possible target on which install Aglets.

The following paragraphs show how to install Aglets from the three available forms: compiled package, CVS, compiling from sources. In the following, an installation over a Unix machine will be shown, even if steps are the same for all other supported platforms. It is supposed you have all required Java commands in your PATH, thus they can be executed starting from their short name. Please read the first of the following paragraphs, since it is the more detailed one and other two rely on that for the directory structure, execution of common commands, and so on.

1.1 Installing from compiled packages

This is the recommended way, since compiled packages contain stable versions of the platform and of the library (ASDK). If you are not a developer, you should install Aglets starting from compiled packages. Both the library and the platform are shipped within a single file, a jar archive (Java
ARChive), with a name that reflects the version of Aglets it contains. In the following we will refer to the version 2.0.2 of Aglets (the latest stable at the moment of writing), which archive file is:

```
taglets-2.0.2.jar
```

The following steps detail how to install Aglets starting from the above archive.

1. Decompress the archive:
   Since Aglets comes as compressed archive, you need first to decompress it. Please take care that the archive will be decompressed in the current directory, thus it is better to create a container directory for your aglet installation. An example can be `/java/aglets`. Once you have created the directory, copy the archive file into it and execute the jar command to decompress the archive:

   ```
jar xvf aglets-2.0.2.jar
```

   During the decompression you will see a few of lines scrolling on the screen, indicating what is going to be extracted:

   ```
   luca@linux:/java/aglets> jar xvf aglets-2.0.2.jar
   created: META-INF/
   extracted: META-INF/MANIFEST.MF
   created: bin/
   extracted: bin/agletsd.bat.in
   extracted: bin/agletsd.in
   extracted: bin/ant
   extracted: bin/ant.bat
   extracted: bin/build.xml
   extracted: bin/daemoncontrol.bat.in
   extracted: bin/daemoncontrol.in
   extracted: bin/lcp.bat
   created: cnf/
   extracted: cnf/aglets.props
   extracted: cnf/agletslog.xml
   extracted: INSTALL.html
   created: lib/
   extracted: lib/jaxp.jar
   extracted: lib/tahiti.properties
   extracted: lib/log4j.jar
   extracted: lib/parser.jar
   extracted: lib/aglets-2.0.2.jar
   extracted: lib/ant.jar
   ```
extracted: lib/crimson.jar

Once you have extracted the archive, you should see a set of sub directories as follows:

- **bin** will contain executable programs for the Aglets 2 platform, such as the daemon in charge of receiving incoming agents. Furthermore it contains files required by further installation steps;
- **cnf** contains configuration files for the Aglets platform;
- **public** contains a few examples of agents, and should be your root directory as base of your own agents;
- **lib** contains the Aglets 2 library (as a jar archive) and other libraries required by the Aglets technology.

Please read **README** and **INSTALL** files (if any), since they could include specific documentation related to the version you are installing and that it is not yet included in this manual.

2. Install the platform:
   To install the platform you need to run Apache Ant, a tool expressively made to compile and install Java applications. Aglets 2 is shipped with a version of Ant that is suitable to install the platform, nevertheless it is possible to use another version of Ant (is recommended a version greater than 1.5). Check the Ant project web site at the Apache Foundation site [http://www.apache.org](http://www.apache.org) to get more information about Ant.

   To install Aglets with the shipped Ant, you need first to enter the **bin** directory, where the Ant buildfile build.xml is present, and then run:

   ```
   luca@linux:/java/aglets> cd bin/
   luca@linux:/java/aglets/bin> chmod 755 ant
   luca@linux:/java/aglets/bin> ./ant
   Buildfile: build.xml
   ...
   BUILD SUCCESSFUL
   ...
   ```

   *Total time: 8 seconds*

   During the library build/installation you will see messages coming from the Aglets maintainer about the current version; please read them since they could contain information not yet reported in this manual.
3. **Set up policy:**
   As other Java applications, the Aglets platform requires entries in the Java policy file (usually \texttt{7.java.policy}) to open sockets, execute agents, access local files and so on. You can copy entries from the file \texttt{bin/.aglets.policy} (of the Aglets installation) in your \texttt{7.java.policy} or you can ask Ant to do it for you. This is the recommended way, since it can change depending on administrators wills and since is a more transparent and standard way. Furthermore, Ant will install a base keystore for you. Aglets requires a keystore in order to contain keys for secure agent migrations; usually the keystore is contained in the \texttt{7.keystore} file.

   To install both the policy entries and the keystore in your home directory, launch \texttt{ant} specifying the \texttt{install-home} option:

   ```
   luca@linux:/java/aglets/bin> ant install-home
   Buildfile: build.xml
   
   install-home:
   [echo] Copying .java.policy file...
   [copy] Copying 1 file to /home/luca
   [echo] Copying .keystore file...
   [copy] Copying 1 file to /home/luca
   
   BUILD SUCCESSFUL
   Total time: 1 second
   
   Security note:
   Please consider that both the policy entries and the keystore file are meant to allow Aglet users to quickly and easily start using the platform; you should strictly check the security options before running the Aglets platform over a production machine.
   ```

4. **Set up environment variables:**
   In order to get the Aglets platform running, you should set the following environment variables to the installation directory of Aglets: \texttt{AGLETS_HOME} and \texttt{AGLETS_PATH}. Furthermore, to run the Aglets platform in a more comfortable way, add the \texttt{bin} directory of the Aglets installation to your \texttt{PATH}. If you are running a Unix-Linux system with Bash, you can do the following:

   ```
   export AGLETS_HOME=/java/aglets
   export AGLETS_PATH=$AGLETS_HOME
   export PATH=$PATH:$AGLETS_HOME/bin
   ```

   while in a Microsoft Windows system you can do:
set AGLETS_HOME=c:\java\aglets
set AGLETS_PATH=%AGLETS_HOME%
set PATH=%PATH%;\%AGLETS_HOME%\bin

or you can configure environment variables from the control panel.

5. Run the Aglets server:
Once you have installed the Aglets platform and the keystore, you can run the default Aglets server, that is called Tahiti. Tahiti can be executed through the command *agletsd*, that starts the Aglets server:

luca@linux:/java/aglets/bin> agletsd

Tahiti will ask the user to authenticate itself, showing a window with fields for username and password (see figure 1.1); if the user has installed the default keystore the username is *anonymous* and the password is *aglets*. Once the user has logged in, the Tahiti main window is displayed (see figure 1.2). Within this window the user can manage the server, creating and disposing agents, getting information, and so on.

Do not worry to much if, at start time, the *agletsd* command shows a few warnings like the followings:

AgletRuntime is requested to get unknown user’s certificate
Signature of shared secret is incorrect.
secret is null.
[Warning: The hostname seems not having domain name.
Please try -resolve option to resolve the
fully qualified hostname
or use -domain option to
manually specify the domain name.]
Figure 1.2: Tahiti main window.

Figure 1.3: Confirmation required for server shutdown

They are warning related to your network connection, and you will see how to fix them in further chapters.

Please note that the Tahiti main window gives information about the server; it suffices to look at the main window title to know which port the server is listening on (by default 4434) and within who is running (the username).

To stop the server, simply click on either the close button in the window title bar (usually an 'x') or select Exit from the Aglet menu. In both cases, Tahiti will ask you for a confirmation (see figure 1.3); clicking on 'OK' will shutdown the Aglets server (killing all running agents and freeing resources), 'Cancel' will leave Tahiti running and 'Reboot' will force a server restart.

1.2 Installing from the CVS

You can install the Aglets platform from the CVS repository. The following are the required steps:

(a) Create the directory for the repository:

You need to create a directory playing as a container for the
CVS repository. In this directory you will download a copy of all sources currently inserted in the CVS repository.

(b) Log in to the CVS server:
   To log in to the CVS server do the following:

```
luca@linux:/java/aglets/bin> cvs
   -d:pserver:anonymous@cvs.sf.net:/cvsroot/aglets
   login
```

The server will respond with

```
Logging in to
   :pserver:anonymous@cvs.sf.net:2401/cvsroot/aglets
CVS password:
```

No password is required for anonymous access, so simply leave it blank. After the login, the command prompt of your shell will be shown again. Now you are logged in the CVS server, and you can download the source tree.

(c) Download the source tree:
   You need to download from the aglets module, thus do:

```
luca@linux:/java/aglets/bin> cvs
   -d:pserver:anonymous@cvs.sf.net:/cvsroot/aglets
   checkout aglets
```

The system will download (or update if you have already a version of the CVS repository) each source file in the on-line repository, placing files into a subdir with the same name of the module (in this case aglets). After that you can logout doing:

```
luca@linux:/java/aglets/bin> cvs
   -d:pserver:anonymous@cvs.sf.net:/cvsroot/aglets
   logout
```

(d) Compile the downloaded source tree:
   The source tree you have downloaded must be compiled in order to build the Aglets library and platform. Enter in the src subdirectory and run Ant there, you will see the compilation of all sources. At the end of the compilation, the library and the platform will be installed in the module directory (i.e., the parent directory of the src one).

1.3 Compile from the source

The compilation of the source tree can be done easily through Ant, as already described in the previous sections. Once you have
downloaded the source tree (either from HTTP or CVS), compile the whole tree entering in the tree directory (the one that contains a file called build.xml) and running ant, as already described in this chapter.
Chapter 2

Managing login data

As already detailed in the installation sequence, the Aglets platform uses a default couple username/password for user authentication. You can create a new login (i.e., a new couple username/password) or modify the password of an existing username using the keytool command shipped with the Java 2 platform. This chapter will show a base use of the keytool command, in order to allow you to manage certificates and logins. For a better description of the keytool capabilities, refer to the official SUN documentation.

To manage information stored in the keystore you need to own the keystore password, that will be asked for each operation. The keystore password protect the whole certificate database, and should not be confused with the user’s password, required to access a single certificate. Furthermore, it is not a good idea to have the keystore password identical to a certificate password.

2.0.1 Creating a new account

To create a new account (i.e., a couple username/password) start the keytool command specifying the new username. To keep it simple, consider the creation of an account with myAglet as username and buzzle as password. Here there is the first step of the creation:

```
luca@linux:/java/aglets/bin> keytool -genkey -alias myAglet
Enter keystore password:  aglets
```

The command asks the keystore password, that for the default Aglets keystore (i.e., the keystore installed by Ant) is aglets. Please note that the keystore password is echoed as plain text on the terminal, and this means you should manage the keystore away from other people eyes.

Once you have entered the correct keystore password, the command will ask you a few information, such as your name, you department, and so on. All those information are required to generate a certificate that identifies the user; that certificate will be stored in the keystore. The following is a dump of a possible set of information I could use:
What is your first and last name?
[Unknown]: Luca Ferrari

What is the name of your organizational unit?
[Unknown]: AgentGroup

What is the name of your organization?
[Unknown]: University of Modena and Reggio Emilia

What is the name of your City or Locality?
[Unknown]: Modena

What is the name of your State or Province?
[Unknown]: Italy

What is the two-letter country code for this unit?
[Unknown]: it

Is CN=Luca Ferrari, OU=AgentGroup, O=University of Modena and Reggio Emilia, L=Modena, ST=Italy, C=it correct?
[no]: yes

Finally, keytool will ask you the password to use for the above new username. 
Be careful writing the password, since it will be asked once (not twice as many password programs do) and will be echoed as plain text on your monitor.

Enter key password for <myAglet>
(RETURN if same as keystore password): buzzle

luca@linux:/java/aglets/bin>

When the keytool program finishes, the command prompt is displayed. Now you can use the new couple of username and password to login in the Aglets platform.

2.0.2 Changing the password of an existing account

To change the password of an existing username, use the `keypasswd` option of the keytool command. Suppose that you want to change the password of the username `myAglet`, the following is what you have to do:

`luca@linux:/java/aglets/bin> keytool -keypasswd -alias myAglet`  
Enter keystore password: aglets

First of all, the command will ask you the password of the whole keystore, that as already written, by default is `aglets`. After that, the old password is required:

Enter key password for <myAglet>buzzle

Finally, the new password is required. Please note than, even if here the password is asked twice, preventing thus miswritings, the password value is printed also on the screen, and this requires nobody is watching at your password.
New key password for <myAglet>: buzzle2
Re-enter new key password for <myAglet>: buzzle2
luca@linux:/java/aglets/bin>

Now you have changed the password of the specified username, and can use the new password to login in the Aglets platform.

2.0.3 Deleting an account

If you want to delete a whole account, you can use the delete option of the keytool command. For example, if you want to delete the myAglet account, do the following:

luca@linux:/java/aglets/bin> keytool -delete -alias myAglet
Enter keystore password: aglets
luca@linux:/java/aglets/bin>
\end{center}

Be aware of what you are doing, since the command is very silent! As you can see, only the keystore password is required, after that the deletion happens without asking any user confirmation.

2.0.4 Listing the content of the keystore

To view which certificates are handled by the current keystore, simply do:

keytool -list
Enter keystore password: aglets

that will print something like the following:

Keystore type: jks
Keystore provider: SUN

Your keystore contains 2 entries

anonymous, Sep 6, 2004, keyEntry,
Certificate fingerprint (MD5):
aglet_key, Sep 6, 2004, keyEntry,
Certificate fingerprint (MD5):

The output above shows that only two certificates are present in my current keystore, and that the username to access those certificates are anonymous and aglet_key. The above certificates are created by the Ant installation.
2.0.5 User’s Configuration Files

Aglets stores, for each users, a few configuration files in the user’s home directory. In particular, Aglets will create a directory called .aglets, containing a few subdirectories as shown below:

- **cache** it will be used by a running platform to cache information about agents, and agents themselves (for example when they will be deactivated).

- **security** it contains a policy file and the secrets created with Tahiti.

- **spool** contains a directory for each combination host/port the platform has been bound to. In each directory, a few files used by the run-time system (such as platform properties) are stored.

- **users** contains a directory for each registered user (i.e., each user with an alias in the keystore). Each directory stores preferences of the user, such as the Tahiti window size, agent lists, etc.
Chapter 3

Using the Tahiti server

This chapter describes how to use the Tahiti server, that is the default server for the Aglets platform, in order to manage agents on your system.

3.1 Tahiti GUI

This section covers the use of the Tahiti GUI (Graphical User Interface), that is used as default user interface to the user when you launch the agletsd command (see figure 1.2). Tahiti presents a main window, with a menu bar, a list of running agents, and toolbar. The main area of the window is covered by the running agent list (“agent list” henceforth), which gives information about agents. Most of operations are aglet-dependent, that means act on a specific agent. To specify to the server which aglet you are referring to, you have to select the agent from the agent list clicking on its row with the mouse; the row will become highlighted to notify that you are working on that agent.

Following sections cover how to use Tahiti in both GUI and command line mode.

3.1.1 The Aglet menu

Entries of the Aglet menu are displayed also in the toolbar as buttons. This menu allows administrator to handle the agent life cycle, creating new agents, disposing other agents, etc (see figure 3.1). Please consider that a lot of entries of this menu act on specific agent instances, so you need to select an agent in the Tahiti agent list before you can work on it. Each entry of the menu is detailed in the following.

- **Create**
  Allows administrators to create new agent instances. Once selected, a dialog window will appear, requesting to insert the agent class name
(fully qualified, with the name of the package), the URL and other options (see figure 3.2).

In the creation dialog window you have to specify the class name of the aglet you want to create. This can be specified either manually writing the class name (with its package) in the Aglet name field or selecting an existing class from the list of known agents. Once you have inserted the aglet name, you can click on the Create button to create the new agent (a new row will appear in the Tahiti main window, specifying the agent name and other information about it). The Add to list and Remove from list buttons allow users to insert and remove new agent names in the known agent list. The Reload class and create button forces an instantiation of the agent class without using the class loaders cache. This can be useful if you have modified the agent class and have already loaded it.

The Source URL field can be useful to load agent which classes are not in the aglet root (usually public). You can specify the location starting from which the class name should be found, thus the agent name results fully qualified by the URL and the class name.

- **Dialog**
  Sends a message of the kind dialog to the selected agent. This can be useful to display user windows on request. For example, the HelloAglet shows a dialog window only if the Dialog option (i.e., a "dialog" message) is activated, as shown in the followin code:

```java
public void dialog(Message msg) {
```
Figure 3.2: Agent creation dialog window.

```java
// check and create a dialog box
if (my_dialog == null) {
    my_dialog = new MyDialog(this);
    my_dialog.pack();
    my_dialog.setSize(my_dialog.getPreferredSize());
}

// show the dialog box
my_dialog.setVisible(true);
}

public boolean handleMessage(Message msg) {
    if (msg.sameKind("atHome")) {
        atHome(msg);
    } else if (msg.sameKind("startTrip")) {
        startTrip(msg);
    } else if (msg.sameKind("sayHello")) {
        sayHello(msg);
    } else if (msg.sameKind("dialog")) {
        dialog(msg);
    } else {
        return false;
    }
}
Figure 3.3: Confirmation required to dispose an agent.

Figure 3.4: Confirmation required to clone an agent.

return true;
}

- **Dispose**
  The *Dispose* entry allow administrators to kill a running agent. Once you have selected an agent in the Tahiti agent list, and have clicked the *Dispose* button (or have selected the entry from the menu), Tahiti will ask you a confirmation before it proceeds (see figure 3.3). If you are sure of you want to kill that aglet, click on the *Dispose* button in the dialog window, otherwise click on *Close*.

- **Clone**
  The *Clone* entry allows administrators to create an identical copy of a running agent. Tahiti will show you a confirmation dialog (see figure 3.4) where you can click on the *Clone* button in order to proceed. If you do not want to clone the agent, click on *Close*. After cloning the selected agent, Tahiti will show a new row in the agent list, since a new agent has been created.

- **Aget Info**
  This entry opens a dialog window with different data related to the agent, as the key, the owner id, the creation date, class name, etc. All information about security comes from the certificate stored in the keystore database (see figure 2), while agent class info are those specified at the creation time. The dialog window (see figure 3.5) does not allow users to modify the agent information. To close the window
click on the Close button.

- **Kill**
  This option is present in the menu only, and is similar to the Dispose one, except it forces an agent to shutdown without waiting its disposing operations. In other words, killing an agent is an harsh way to terminate an agent, while disposing it can sound more friendly. The kill option could be useful to stop looped agents, or to quickly terminate malicious agents, but the disposing one should be preferred for normal agent shutdown.

- **Exit**
  The Exit option causes Tahiti to shutdown, disposing each agent that is running. As already written, Tahiti will ask the user for a confirmation about the shutdown.

### 3.1.2 The Mobility menu

The Mobility menu allows control over the migration of agents and their activation/deactivation. Similarly to the Aglet menu, since each option works on a specific agent instance, you need first to select an agent in the Tahiti agent list. Each entry of the menu is detailed in the following, the menu is reported in 3.6.

- **Dispatch**
  This entry orders an agent to migrate to another Aglets platform. You need first to select the agent instance to migrate, and then select
the `Dispatch` option. A dialog window will pop up, asking for the destination URL (see figure 3.7); URL for Tahiti (and more in general for Aglets application) should use the ATP (Agent Transfer Protocol) as protocol, thus for example a valid URL could be `atp://somehost`. If you are running a couple of Tahiti instances on ports 4434 (default) and 5000, you can move the example agent `DisplayAgent` to the latter platform using a URL as `atp://localhost:5000`. When you click on the `Dispatch` button, you aglet will be sent to the destination platform. If, for some reason (the aglet cannot migrate, is not serializable, etc.) the migration cannot be successfully done, your agent will stay on the current platform and a dialog window will notify to you the exception (see figure 3.8).

The dispatch dialog window offers to you the capability to store the
Figure 3.8: An exception during the migration occurred.

Figure 3.9: The retract dialog window.

URL to which you are sending an agent to a list of known URLs, called Address Book. The buttons Add to AddressBook and Remove gives to you the capability to add and remove entries (as URLs) from the above list. Please note that, until you add an URL to the address book, you will not be able to retract agents sent to that URL.

- **Retract**
  The Retract menu entry makes the opposite of the Dispatch one: it forces a migrated agent to come back home. To do this, you need to know where the agent is currently, thus the platform can send a message to the other platform forcing the agent to come back home. Once selected, the Retract option will show you a dialog window as that in 3.9. You need to select the remove agent server from the Address Book list (that must be filled at the dispatch time), and then the agent among those available on the remote host. After you have selected the agent to come back, you can click on the Retract button. Now the agent will be forced to come back, and you should see it running again on your platform.

- **Deactivate**
  This option forces Tahiti to stop the execution of the selected agent, serializing it locally, and deserializing when the agent is reactivated.
Tahiti will pop up a dialog window (see figure 3.10) where you can insert a sleeping time (in seconds) for the agent. Clicking on the Deactivate button causes the agent to be deactivated.

- **Activate**
  This option makes the opposite of the Deactivate one: activate a sleeping agent. The agent will be deserialized and its execution will start again. Please note that this command runs silently, and the only thing you will see in the Tahiti window is a message in the status bar, that notify the activation of the agent.

### 3.1.3 The View menu

This menu (see figure 3.11) offers a few tools to take care of what is going on: memory usage and Tahiti logs. In the followin each menu entry is detailed.

- **Memory Usage**
  This option opens a dialog window with a progress bar that shows the memory usage respect the Java run-time system (see figure 3.12). The red part of the bar represents the memory used by the Aglets platform, while the blue bar represents the memory still available from the Java run time environment. The dialog window is managed by a separated thread, thus the progression bar updates itself every second.

- **Log**
  This option opens the dialog window shown in figure 3.13, that reports a brief log of operations done by the Aglets platform (agent creation, dispatching, etc.). The Clear Log button causes the flush of the log content and its reset, thus a new clean log is used.
Figure 3.12: The dialog window that shows the memory usage.

Figure 3.13: The log dialog window.

- **Java Console**
  This option is not exploitable.

3.1.4 The **Options** menu

This menu, shown in figure 3.14, allows administrators to change settings about the whole aglet server engine, to set up protections and policies, and so on. In the following, a detailed explanation of each entry is given.

- **General Options**
  This entry opens a dialog window that allows to set up global preferences, related to the start up of Tahiti and to its look feel (see figure 3.15). The **Font** section allows the user to select which font Tahiti should use to display information, with its style (e.g., bold) and its size (in points). The effective use of the selected font depends on which fonts are available to the Java system. The **List view** section allows to set up how Tahiti have to show agents in the agent list. The order can be ascent/descent, and can be done by the agent class name, the creation time, the event order (i.e., what happened to the agent),

![Options Menu](image)

Figure 3.14: The **Options** menu.
Figure 3.15: The general options dialog window.

etc.

The **Startup** section allow you to select a specific agent to be loaded at the Tahiti start time. You have to click on the **On Startup** check button and then to enter the fully qualified agent class name in the following text field.

The **Clear Class Cache Now** button of the **Class Cache** section, allows administrator to reset class loaders caches, thus new instances of already loaded agents will be created after a reload of their class. This can be useful if you are testing an agent which class is changing frequently.

To apply all modifies you have done through the above dialog, you have to click on the **OK** button, while the **Close** one will not apply modifies. The **Restore Defaults** button reset any changes to the Tahiti default.

*Network Preferences*

This entry opens a dialog window that allows users to manage network settings, like the use of proxies, HTTP tunneling, authentication requests, and so on. The dialog is shown in figure 3.16.

The **Http Tunneling** section allows you to specify if Aglets should accept http requests, if it must send agents through the http protocol (useful if you are running Tahiti behind a firewall), and which proxy should be use. You can specify either a DNS host name or an IP address, along with the port the proxy is accepting connections on. You can also specify a domain to which dispatch agents without passing through the proxy, that means with a direct connection.
The Authentication section contains several buttons to configure security on incoming connections. The Do Authentication on ATP Requests checkbox forces, if checked, authentication on each incoming connection over ATP, that means on each incoming agent.

The Create a new shared secret button allows users to create new secrets for a specific domain. The button will open a dialog like the one in figure 3.17. The user has to enter a domain and a couple username (called alias) and password that must match a couple in the keystore database.

The Remove a shared secret button allows you to remove a secret selecting it from the list of registered secrets, as shown in figure 3.18. Please note that you have to provide the password that holds the alias (i.e., the username) the secret has been created with.

The Export a shared secret button opens a dialog as the one shown in figure 3.19, that allows users to select the domain the secret is associated to, and to store it in a file which name is written in the File name
text field. Once you have saved the secret in the file, Tahiti will show you a dialog window with the absolute path of the secret file, thus you can easily find it (see figure 3.20). The Import a shared secret button opens the dialog window shown in figure 3.21, which asks the user for the file name of the secret to import.

- **Security Preferences**
  This entry opens a dialog like the one in figure 3.22, that allows administrators to set up Java permission for agents and other Java classes. The window is split in two main parts: on the left the user can select the codebase of a Java classes (either an agent or a normal class), on the right the user can assign permissions. The use of this window is very similar to the use of the Java policytool program. Furthermore, since it works as the Java security mechanism, all permissions will not be ex-

Figure 3.20: Tahiti gives you information about the full path of the secret file.
Figure 3.21: Importing a shared secret.

Figure 3.22: The security options dialog window.

explained here; you can find more details on the Java 2 documentation. Modifies will be applied to the /aglets/security/aglets.policy file. Please take care when using this option, since it does not work always right; thus you should check that the policy file has changed.

• **Server Preferences**
  This entry opens a dialog window (see figure 3.23) that allows users to set a few parameters like the server public root, that is the directory where Tahiti searches for agents. Unfortunately, this option seems to have a few bugs and does not work very well.

3.1.5 The **Tools** menu

This menu gives users access to a few tools more related to the Java virtual machine than to the Aglets platform itself. Figure 3.24 shows the menu appearance, while in the following you can find a detailed description of each entry.

• **Invoke GC**
  The selection of this entry will force a call to the Java garbage collector, in order to force a memory check and to free no more used
Figure 3.23: The server preferences dialog window.

Figure 3.24: The Tools menu.
objects/agents. You can use this menu entry if you believe your system memory has not been freed, or after a large agent killing.

- **Threads**
  This option causes Tahiti to dump a brief information about all existing threads in the JVM. The dump is displayed in the Java console (terminal), and is similar to the following one:

  ```java
  {java.lang.ThreadGroup[name=system, maxpri=10]}
  + Threads
  - Thread[Reference Handler,10,system] alive
  - Thread[Finalizer,8,system] alive
  - Thread[Signal Dispatcher,10,system] alive
  - Thread[CompilerThread,0,10,system] alive
  ```

- **Debug**
  The only visible thing is the showing of the string “Debug off” in the Java console. Probably this option was used to enable debug prints for Tahiti components.

- **Ref Table**
  Does not show anything. Probably it was a dump mechanism for the Tahiti and Aglets internal reference table.

### 3.1.6 The Help menu

This menu does not provide a real help, rather credit information. Most of the entry are not working in the current release of Tahiti due to the absence of an external program, called openurl, used to point the web browser to a web page. For this reason, do not worry to much if you see exception in the Java console when you select this menu entry.

This menu will probably be fixed in a future release of the Aglets platform.

### 3.2 The Tahiti command line

You can run the Aglets server also from the command line. To enter in the command line, specify one of the following options to the agletsd command: -nogui, -noconsole, -daemon or -commandline (it does not matter where the option is placed respect the other parameters). Tahiti will start in command line mode, asking for the username and the password as for the GUI mode.
Once the user is logged, Tahiti presents a command prompt that allows administrators to manage agents. The command line prompt is not so powerful as the Tahiti GUI, but can be faster and can be used in extreme situations (e.g., when the X server crashes). You can ask for help writing “help”, and you will see a list of available commands:

> help
help Display this message.
shutdown Shutdown the server.
reboot Reboot the server.
list List all aglets in the server.
prompt Display or changes the prompt.
msg on/off Message printing on/off.
create [codeBase] name Create new aglet.
<aglet> dispatch URL Dispatch the aglet to the URL.
<aglet> clone Clone the aglet.
<aglet> dispose Dispose the aglet.
<aglet> dialog Request a dialog to interact with.
<aglet> property Display properties of the aglet.

Note: <aglet> is a left most string listed in the result of list command.

As an example, if you want to create a new agent, you have to use the create command:

> create examples.hello.HelloAglet

and the system will reply with a message showing the operation result, such as:

> Create: examples.hello.HelloAglet from atp:/linux:4434/

If you want to list all agents running in the platform, you have to use the list command; the system will show a list of all agents (in the following example only one is running):

> list
> aglet0 [examples.hello.HelloAglet]

The first word (“aglet0”) represent the agent identity, useful for other commands. For example, if you want to dispose the above agent you have to specify the identity to the dispose command:

> aglet0 dispose
Removed: aglet0
> Dispose: examples.hello.HelloAglet

For a complete list of available commands, digit “help”. To exit from the command line mode you have to shutdown Tahiti, that can be done with the shutdown command (without any option).
Chapter 4

Developing agents with Aglets

This chapter covers basic issues about developing agents with the Aglets library. In the following section it will be shown how to configure main development environments to support Aglets, how to compile and run you own agents and how to explore the library API.

An aglet (i.e., an agent able to run on the Aglets platform) is a simple Java class that must have as base class com.ibm.aglet.Aglet. To define the aglet behaviour you have to override methods of the base class, at least the run() one, and that is all you need to get a complete aglet.

4.1 Configuring your IDE to use the Aglets library

The Aglets library is composed by a single jar archive, called aglets-x.x.x.jar where x.x.x means the library version number (e.g., 2.0.2). In order to compile your own agents, you must have the above jar in your classpath. The following subsections describes how to compile agents with different tools and IDEs.

4.1.1 Using command line tools

You can develop agents as you do with normal Java programs, that means you can write your Java file(s) with your favourite editor, compiling then them with the command line compiler (e.g., javac, jikes). Supposing you have created and saved in a file called FirstAglet.java the following agent:

```java
import com.ibm.aglet.*;

public class FirstAglet
    extends Aglet
{
    public void run()
    {
        System.out.println("\n\tHello\n");
```
you can compile it from the command line, after ensuring you have the Aglets library in your classpath. For example, supposing you have the Aglets platform installed in /java/aglets, you can do the following:

```bash
echo classpath=$classpath:/java/aglets/lib/aglets-2.0.2.jar
```

in a Bash shell, or something like:

```bash
set classpath=%classpath%;c:\Java\aglets\lib\aglets-2.0.2.jar
```

on a Microsoft Windows machine.

After that, just compile your agent from the command line:

```bash
javac FirstAglet.java
```

Even if aglets are like other Java classes, they cannot be run as stand-alone programs, thus you have to run agents into the platform. Before that, you must make agents reachable by the platform itself, that means you must have the agent (compiled class) in the server public root, that is by default the folder `public` of the Aglets platform installation. In other words, you have to copy the classes of your agents under the above folders, thus you can specify the agent class name in the creation dialog (see figure 3.2).

Please note that adding the directory where your classes resides to the classpath variable will not work. It seems as Tahiti has a few bugs in the management of classes and classpath.

### 4.1.2 Using IBM Eclipse

You have to instrument Eclipse accepting the Aglets library in the project you are working on. Supposing you have already defined a project, steps required to use the Aglets library are the following:

1. select Import from the File menu

2. chose the library:
   in the opened dialog window (see figure 4.1), chose Zip file and click on Next button. After that, you have to browse the local filesystem in order to find the Aglets library jar (see figure 4.2), then you have to click on the Finish button.

3. test the library:
   you should now see the library packages in the project folder. Importing the package should give you no errors.
Figure 4.1: Importing a package in Eclipse, step 1.

Figure 4.2: Importing a package in Eclipse, step 2.
4.1.3 Using Netbeans IDE

The Netbeans IDE uses an approach similar to the IBM Eclipse one: you have to define in each project jars that must be included. To import the Aglets library, supposing you have already created a project, do the following:

1. mount the library:
   right click on the project name in the file system view (usually on your left), and select *mount* from the contextual menu. In the submenu, select *Archive*, as shown in figure 4.3.

2. choose the library:
   browse the local filesystem to find the library (see figure 4.4, then click on the *Finish* button.

3. test the library:
   you should now see the library packages in the project folder. Importing the package should give you no errors.

4.1.4 Using JBuilder

To quickly enables the Aglets library in the Borland JBuilder, you have to follow the steps below:

1. select *Configure JDKs* from the *Tools* menu.
2. choose the library:
   push the Add button and browse your local filesystem in order to find
   out the Aglets library jar, and then select it.

3. check the importation of the library:
   once you have selected the library, you should see it at the bottom of
   the jar list in the dialog window (see figure 4.5), then click on OK.

   Please note that, doing the above, you will find the Aglets library in all
   projects you will create.

4.2 Base Knowledge

This section provides basic information about the development of an aglet.
In the following you will find which main methods you have to override, how
 to manage incoming messages and how to catch events.

4.2.1 Main Methods of an Aglet

Aglets are agent that follows an Applet-like development way, that means
you have to override a few methods that will be called from an external entity
(the Aglets run-time system) during the agent life. The following piece of
code shows the main methods you should override.

```java
package examples.goofy;
import com.ibm.aglet.*;

public class agletD extends Aglet{
    public void onCreation(Object init){
```
System.out.println("Agent created "+init);
    
    public void run(){
        System.out.println("Agent running");
    }
    
    public void onDisposing(){
        System.out.println("Agent quitting");
    }
}

4.2.2 Message handling

Aglets exploit a communication system based on message passing: two agents that want to communicate each other have to exchange a message. Messages are instances of the Message class, and their kind is specified by a string. An agent that wants to explicitly manage messages has to override the handleMessage(...) method, returning true in the case the message is managed by the agent, false otherwise. The following piece of code shows an agent that handle all messages; you can launch it and send dialogs messages thru the Tahiti GUI.

package examples.goofy;

import com.ibm.aglet.*/

public class agletE extends Aglet{

    public void run(){
        System.out.println("Agent running");
    }
    
    public boolean handleMessage(Message msg){
        System.out.println("Received a message "+msg.getKind());
        return true; // if the message is used
    }
}

There are a few concepts that must be clear when working this message handling. First of all, each aglet executes within a thread, but threads are
managed by the platform and can be shared among agents for efficiency. The efficiency of this approach can be understood thinking at a buyer-seller example: image a couple of agents, with one playing as a seller and one playing as a buyer. In this situation, it is not needed that the buyer agent is active before the seller has put a good on sale, thus there is no reason to use a thread-per-agent approach. Furthermore, the seller can simply send a message to the buyer specifying the good on sale, and then should wait the answer of the buyer (i.e., should deactivate or suspend until an answer comes). Following this example, it should be clear that the number of active threads (i.e., agents) could be reduced at one per time. Aglets exploits this condition in its whole design: if agents can share the same thread, no additional threads will be created. In other words, the number of agents and threads are not strictly related.

Due to the Aglets thread model, it is important to understand that each message is delivered by a thread, that can be different from the one the agent runs (or have run). Since aglets are implicitly synchronized, a message can be delivered if the agent is active and running, that means while your agent is in the \texttt{run()} method (or another method). In fact, while the agent is in the \texttt{run()} method (or another one), there is a thread active in the agent itself, and another thread (the message deliver thread) cannot deliver the message because of the Java synchronization.

From the above considerations, it is possible to see how an agent performing an (in)finite loop will be unable to receive and manage any incoming message. Nevertheless, there is a way to force an agent to release the lock, and this can be done with the \texttt{exitMonitor()} method, that causes all waiting messages to be dequeued and, at the same time, all threads locked on a \texttt{waitMessage()} to be resumed. Please be aware that forcing an agent to release locks could produce race conditions.

### 4.2.3 Events

Aglets supports an \textit{event/event listener} model, where an agent can register event listeners to particular kind of events, thus it can trigger those events. There are mainly three kind of events, tied to different scenarios of the agent life cycle: doning, mobility and persistency. Table 4.1 shows each kind of event, with types and event listener that can be associated to.

### 4.3 Code Examples

This section provide a few code examples about running aglets. The code shown here is meant for a didactic use only, and does not preptend to be professional.
### Event Table

<table>
<thead>
<tr>
<th>Event kind (class name)</th>
<th>Time</th>
<th>Event listener</th>
<th>Method of the event listener</th>
</tr>
</thead>
<tbody>
<tr>
<td>CloneEvent</td>
<td>before cloning</td>
<td>CloneListener</td>
<td>onCloning(..)</td>
</tr>
<tr>
<td>CloneEvent</td>
<td>after cloning</td>
<td>CloneListener</td>
<td>onClone(..)</td>
</tr>
<tr>
<td>MobilityEvent</td>
<td>before migrating</td>
<td>MobilityListener</td>
<td>onDispatching(..)</td>
</tr>
<tr>
<td>MobilityEvent</td>
<td>when the agent arrives</td>
<td>MobilityListener</td>
<td>onArrival(..)</td>
</tr>
<tr>
<td>MobilityEvent</td>
<td>when the agent is being retracted</td>
<td>MobilityListener</td>
<td>onReverting(..)</td>
</tr>
<tr>
<td>PersistencyEvent</td>
<td>after the agent activation</td>
<td>PersistencyListener</td>
<td>onActivation(..)</td>
</tr>
<tr>
<td>PersistencyEvent</td>
<td>before the agent deactivation</td>
<td>PersistencyListener</td>
<td>onDeactivating(..)</td>
</tr>
</tbody>
</table>

Table 4.1: Available events in Aglets.

#### 4.3.1 A base agent

The following class shows a simple aglet that, once loaded, prints a few messages on the standard output (i.e., the console where you launched the agletsd command).

```java
import com.ibm.aglet.*;

public class FirstAglet extends Aglet {
    public void run() {
        System.out.println("\n\tHello\n");
        for (int i=0; i<10; i++) {
            System.out.println("\n i is "+i);
        }
    }
}
```

#### 4.3.2 Event Listeners

The following code example shows how MobilityListener, CloneListener and PersistencyListener can be used. First of all, have a look to the listener class:

```java
package examples.goofy;

import com.ibm.aglet.*;
import com.ibm.aglet.event.*;
```
public class myListener
    implements MobilityListener, CloneListener, PersistencyListener
{
    // mobility listener methods
    public void onArrival(MobilityEvent event){
        System.out.println("Agent arrived "+event);
    }

    public void onDispatching(MobilityEvent event){
        System.out.println("Before moving..."+event);
    }

    public void onReverting(MobilityEvent event){
        System.out.println("Before coming back home..."+event);
    }

    // clone listener methods
    public void onClone(CloneEvent event){
        System.out.println("I’m the clone "+event);
    }

    public void onCloned(CloneEvent event){
        System.out.println("A clone of myself created "+event);
    }

    public void onCloning(CloneEvent event){
        System.out.println("Someone is cloning myself "+event);
    }

    // persistency listener methods
    public void onActivation(PersistencyEvent event){
    }
System.out.println("Activating "+event);
}

    public void onDeactivating(PersistencyEvent event){
        System.out.println("Deactivating "+event);
    }
}

The above listener defines methods to catch events at different time, as explained by the code itself. The following agent registers the above listener and use it to trigger events:

package examples.goofy;

import com.ibm.aglet.*;
import com.ibm.aglet.event.*;

public class agletC extends Aglet{
    public boolean move=true;

    public void onCreation(Object init){
        // create a listener object
        myListener listener = new myListener();

        // register a mobility listener
        this.addMobilityListener((MobilityListener)listener);
        // register a clone listener
        this.addCloneListener((CloneListener)listener);
        // register a persistency listener
        this.addPersistencyListener((PersistencyListener)listener);
    }

    public void run(){
        System.out.println("HELLO!");
    }
}

For example, after a dispatching, mobility events are triggered and the agent prints, in the source console, the following statements:
Before moving...MobilityEvent[DISPATCHING]

while in the destination console prints:

Agent arrived MobilityEvent [ARRIVAL]
HELLO!

To better understand how event listeners work, execute the above agent
and try cloning, dispatching and deactivating it; have a look at what mes-
ages are printed out in all the consoles.

4.3.3 Remote Messaging

The following code shows how agletA can sends a remote message to the
agent agletB. Please note that it is needed to know the agletID of the
remote agent to communicate with it.

```java
package examples.goofy;

import com.ibm.aglet.*;
import java.net.*;

/**
 * Clone an agent and send a remote HELLO message to it.
 */
public class agletA extends Aglet{

    public void run(){
        try{
            // get the aglet context
            AgletContext context = this.getAgletContext();

            // create an agletB instance
            AgletProxy toMove = context.createAglet(null,
                        "examples.goofy.agletB",
                        null);
            // save the new aglet ID
            AgletID remoteID = toMove.getAgletID();
            System.out.println("The new agent has ID = "+remoteID);

            // migrate the new agent
```
String remoteContext = "atp://localhost:5000";
URL url = new URL(remoteContext);
toMove.dispatch(url);

// get the remote proxy
AgletProxy remoteProxy = context.getAgletProxy(url, remoteID);
// send a message to the remote agent
remoteProxy.sendMessage(new Message("HELLO"));

}catch(Exception e){
   System.out.println("Exception "+e);
}
}

///////////
// agletB

package examples.goofy;

import com.ibm.aglet.*;

/**
 * Receive a remote message.
 */
public class agletB extends Aglet{

   public void run(){
try{
   // get my ID
   AgletID myID = this.getAgletID();
   System.out.println("\nMy ID is "+myID);

}catch(Exception e){
   System.out.println("Exception "+e);
}
}

// handle the message
public boolean handleMessage(Message msg){
if(msg.sameKind("HELLO")) {
    System.out.println("HELLO msg received");
    return true;
}
return false;
}

Please note that, even if the getAgletProxy(...) method called in the above code is deprecated, a call to the no-deprecated method such as:

AgletProxy remoteProxy = context.getAgletProxy(remoteID);

will not work, since it can work only with the local agents. The use of the MAF (Mobile Agent Finder) will work better, but at the moment there is not a lot of documentation about how to use it in Aglets.

### 4.3.4 A sleeping aglet

In general, it is not possible to make an aglet sleeping, since threads should not be managed directly from the developer. You can use something similar, but more expensive, to simulate sleeping, that is deactivation: you can deactivate and reactivate an agent, but you must be careful since deactivation means that the agent is serialized and its execution restarts from the beginning. This means that the following code will run indefinitely:

```java
import com.ibm.aglet.*;
import java.io.*;

public class agletF2 extends Aglet{
    public void run(){
        for(int i=10; i>0; i--){
            System.out.println(i+" seconds left!");
            try{
                this.deactivate(1000);
            }catch(IOException e){
                System.out.println("Ops!");
            }
        }
    }
}
```
Since, after a reactivation, the execution of the agent restarts from the run() method, the agent will restart the for loop from the same point (i.e., i=10). Instead, the following code is correct and works:

```java
import com.ibm.aglet.*;
import java.io.*;

class agletF extends Aglet{
  int i=10;

  public void run(){
    for(i>0;){
      i--;
      System.out.println(i+" seconds left!");
      try{
        this.deactivate(1000);
      }catch(IOException e){
        System.out.println("Ops!");
      }
    }
  }
}
```

Nevertheless, it should be clear how deactivation cannot substitute the sleeping mechanism, and that making a thread to sleep will produce strange effects on the whole platform (such as locking the message passing mechanism). This is due to the fact that the Aglets platform uses a set of threads (i.e., a pool) to work efficiently, thus the same thread can be shared by different agents. There is a trial feature, done with the method suspend(..) of the class AgletProxy that can be used as a sort of sleeping command. Unfortunately, it does not work yet, and in fact the following agent causes the throw of an IllegalThreadStateException:

```java
import com.ibm.aglet.*;

class agletZZ extends Aglet{
  public void run(){
    try{
      for(int i=10;i>0;i--){
        System.out.println(i+" seconds remaining");
        this.suspend(1000);
      }
    }catch(AgletException e){
```
System.out.println("Ops!");
}
}

**Warning on this code example**  Please note that running the agent agletF2 will have tremendous effects on your system. Due to the Aglets thread management, you will not be able to destroy (either by killing or de-activating or disposing) the running agent, while the latter will run forever. Even stopping an restarting the Tahiti server will not solve the problem, thus the only things you can do is to perform a *clear start* (see the FAQ section) or to manually remove the spool file in the $HOME/.aglets/spool/hostname@runningPort/agletID file, and then restart the Tahiti server.
Chapter 5

FAQ & Configuration Files

This chapter contains a reviewed and update FAQ, and a list of the original configuration files shipped with the version of the platform. You should first have a look to this chapter before posting a problem over the mailing lists.

5.1 FAQ

This section presents a list of Frequently Asked Questions about Aglets. The list has been changed from the old FAQ, since a lot of questions were related to earlier versions.

- **What does AWB stands for?**
  AWB means Aglets WorkBench, and it was the original name given by IBM to the Aglets platform and library. Today’s common trend is to use simply Aglets (with the capital ‘A’) to indicate both the library and the platform, and to explicitly specify the latter when required.

- **What does JAAPI stands for?**
  JAAPI means Java Aglet API.

- **What is Fiji?**
  Fiji was a project to enable Aglets capabilities in a web browser. So far, the project is no more mantained and available.

- **What are differences between the IBM Aglets platform and the open source one?**
  IBM does no more mantains Aglets, thus the version you can download by their server is the 1.03 (or 1.1 beta), while the version available at Sourceforge is greater than 2. Of course, the open source version is more update and functional of the 1.03 version, thus you should use it. Furthermore, the version of IBM was thought as commercial software, that means you requires a license to run it.
Can I run Aglets on Java 2 (JDK1.2 +)?
Yes, of course, and in fact this manual is thought to run Aglets over the Java 2 platform. The first versions of Aglets was developed over Java 1 (JDK 1.3), and often this causes confusions to newbies. Running Aglets 2 over Java 2 is the best way to get the platform working.

Are there any archives of the Aglet Mailing list?
Yes, visit the Aglets web page at Sourceforge.net to get information about mailing lists, archives and how to subscribe.

I need some help! What should I do?
Reading this manual is a good start. Unfortunately, at time of writing this manual there are not a lot of documentation sources available. There are still a few pages at the IBM Tokyo Research Laboratory web site, but they are quite old and no more maintained. See the Aglets web site at Sourceforge.net to get on-line help.

If you need to report some problems or bugs to the mailing lists, please include as much information as possible, in order to allow other participants to rightly understand the problem. The information you should include are:

1. the version of the platform;
2. the operating system;
3. the path where you have installed the platform (for example /home/luca/aglets);
4. the exception stack trace (if an exception is thrown);
5. in the case of a SecurityException, the content of your java.policy file;
6. the code that you believe is causing the misbehaving;
7. a dump of the following environment variables (if set up): classpath, JDK_HOME, JAVA_HOME, AGLETS_HOME. You can obtain the variable value writing in a console:

   # Unix - Linux
   echo \$classpath
   echo \$JDK_HOME
   echo \$JAVA_HOME
   echo \$AGLETS_HOME

   # Windows
   echo \%classpath\%
   echo \%JDK_HOME\%
   echo \%JAVA_HOME\%
   echo \%AGLETS_HOME\%
Be quite and polite when asking help, nobody wants to be bothered with others’ problems. If you find the answer by yourself, post a message as a reply to indicate the answer; it will be interesting for other people and will let them to not waste their time. Finally, do not repeat the message if you do not get an immediate answer, let people the time to understand and to reply.

- **Are there any public Aglets servers I can send my aglets to?**
  There were a few trials about a public aglet server, but at the best of my knowledge, there is no one server running now.

- **When I launch Tahiti I get: “Please set HOME environment variable!”**
  This indicates an anomalous situation in your operating system: check that the HOME variable points to your home directory. Contact your system administrator to fix this problem, that is not related to Aglets.

- **When I try to access a local file with my aglet the server throws java.jang.SecurityException although all the necessary permissions are set.**
  There is a little known feature of Tahiti (OK, call it a bug ; ) that when Tahiti is installed, it creates a security domain "file://///*" and all permissions are given to this domain. It should mean that any aglet having its codebase on this machine can access any file. But it’s not true. You have to create another security domain describing exactly the path to the codebase of the aglet, grant necessary permissions and then it works.

- **When I try to get my Aglet to access the file ‘test.txt’ I get a FileNotFoundException exception?**
  When attempting to open a file, any path to a file is relative to the directory from which the Aglet was created. Therefore, the solution is that you should specify the file absolute name like this:

  ```java
  FileInputStream inputStream = new FileInputStream("c:/test.java");
  ```

  You can use a single slash (/) in Unix like systems and Windows, or you can specify a double backslash in Windows.

- **Can I run Tahiti with no net connection on Microsoft Windows 95?**
  Yes, even if this system is quite old and I suggest you to run Aglets over a greater system (have you ever thought passing to Linux?). If you have troubles running Aglets over Microsoft Windows 95, try the following:
1. edit the hosts text file that is under the WINDOWS folder and add
   the loopback address entry: 127.0.0.1 localhost;
2. start Tahiti with the -resolve option.

- I want to send my aglet around to lots of different hosts and
to pop up a window at each host, but when I try nothing happens, or I get an exception.
A permission to create top level window is given to any aglet in default
aglets security policy. If you want to modify security preferences, do
the following instructions on every host where your aglet will visit.
Add the following line into files "aglets.policy":

   permission java.awt.AWTPermission "showWindowWithoutWarningBanner";

- Why would not my stand-alone server take my environment
variables into account? This is a feature of the stand-alone servers,
which is they do not take the Aglets related environment variables into
account by default. You should explicitly put the AGLET_PATH and
AGLET_EXPORT_PATH on the java command-line when launching
a stand-alone server (as far as I know, at least).
For example under unix, if your server is called Stand Alone Server:

   java -Daglets.class.path=$AGLET_PATH 
   -Daglets.export.path=$AGLET_EXPORT_PATH StandaloneServer

- Can an aglet perform SNMP operations? Yes - an aglet can
perform SNMP operations by using a Java class that provides SNMP
operations and that can be serialized. A good package to look at is
jmgmt - it is small, straightforward, and has all source included. It is

   Good overviews of various packages can be found at: http://www.mindspring.com/jinda-
say/javamgmt.html and http://www.smmp.cs.utwente.nl/software/pubdomain.html

   Some of the packages use threading- and you have to be careful when
you serialize agents that use threads. The other big restriction on some
of the packages are that they have a commercial license, even if you
are doing not commercial research activity.

- How can an aglet be used as a HTTP Server?
First of all, you should take a look to the example agent WebServerAglet.java
shipped with the Aglets platform examples. Please note that using an
aglet as an HTTP server has a few drawbacks: developing an http server
is not a trivial task and it is subject to security risks, thus you should
be sure of the quality of your server before making it available to third
parties. Furthermore, even if the Aglets platform has a good thread system, it can handle threads in a way that does not fit very well your needs. Finally, running an HTTP server embedded in an aglet, means that your server will be available thru the Aglets running port. For example, if you are running Tahiti at the host myHost, port 4434 (the default for Tahiti), you will be able to reach your HTTP server at the address http://myHost:4434/.

You must also set the options in Tahiti as specified in the comments. If you are coding/adapting the sample - make sure to include the line:

```java
getAgletContext().setProperty("name.test", getAgletID());
```

since this is how Tahiti identifies the aglet to forward the HTTP request to.

Another option is to look at using Fiji. The disadvantage is that the status of Fiji is uncertain right now. Another option is to look at finding/coding Java classes to listen for incoming HTTP requests. There are quite a few HTTP servers written in Java out on the web. Depending on the requirements for the web server (i.e., response time, threading, etc.), there are a few different servers to use.

- **Can an aglet work with other Servers (HTTP, FTP, etc)?**
  The general answer to this question is “yes”. Nevertheless, before start developing your aglet-based server/client, you should take care of a few things. First of all, you must know the protocol, or at least you must have a Java library to interface to the protocol. The Java classes used (in the case) by the aglet must be compatible with the JRE and the Aglets library version you are running, and most important, if they must travel with the aglet, they must be serializable. The latter requirements (serialization), can be overtake if the aglet wil be stationary on a specific host, thus it will never be serialized (of course, this is true if you will never deactivate the aglet!).

- **How does Aglets determine an hostname?**
  Using the configuration of your system, typically using the DNS (Domain Name System).

- **Can an aglet use SSL?**
  (For some good background information on the security model check the aglets book in Chapter 10) It depends on the availability of SSL Java libraries, and how they are compatible with the Aglets library you are running.

- **How is memory used when a message is sent between two aglets?**
You can monitor the memory activity using the Tahiti memory tool: open the *Tools* menu and then select the option *Memory Usage*.

**How can the sleep operation be used in an aglet?**
Please note that threads are hidden to aglets, thus you should not use normal Java thread operations in your aglets. You should use a timer or something similar to obtain the required feature. Using `sleep(..)` is dangerous, since the message passing mechanism will be locked until the sleeping thread wakes up. There is an experimental feature, called `suspend(..)` that could work.

**How can local and remote Aglets discover each other and communicate?**
There are a few options available to attempt to discover remote contexts, depending on what you need to do.

If you want to create a local agent, dispatching then it to a remote context and communicate with the now remote agent, you need to get the remote agent proxy. The proxy discovering can be done with the MAF architecture (at the moment there is no documentation on how to use the MAFFinder in your programs). Another option is to manually keep a track of where your remote agents are, and this can be useful to build critical mission systems, where the MAF architecture can fail down.

See the code example sections.

**I got a message similar to java.util.MissingResourceException: Can’t find bundle for base name tahiti, locale en_US but I do not know how to fix it**
As you can see the problem is caused by the ResourceBundle class, which is used for localization. If you look in the lib directory of your Aglets installation, you can see a text file called tahiti.properties, which contains menu and button entries for the tahiti window. You have to set your classpath to the lib directory, thus the above file can be read by the ResourceBundle class.

**I want to add an agent to the agent list, thus when I click on the Create button I can choose it directly. How can I do this?**
The first and common way of doing it is thru the creation dialog window. Otherwise you can write the agent in a text file, placed in the user’s home directory, and in particular in `$HOME/.aglets/users/username/aglets.properties` and add the agent class name to the line that contains the property `aglets.agentList`. Class names must be add as separated by a blank space, without new line characters.
• **What is FIPA?**
  FIPA means Foundation for Intelligent and Physical Agents, and is a non-profit organization that defines agents’ standards, such as communication languages (called ACLs), interoperability protocols, and so on.

• **Is Aglets 2.0.2 FIPA compliant?**
  No. Aglets is not FIPA compliant, since it has been developed when FIPA was only a proposal. Furthermore, in those days, there was another standard: the **MASIF** (Mobile Agent Systems Intercommunication Facility). Due to this Aglets is MASIF compliant, even if there is not a lot of documentation (or better, there is no documentation) regarding MASIF in Aglets and how well it works. It must be noticed that Aglets is RMI compliant, thus you can use it in combination with the Java’s RMI services. Please note that the fact that Aglets is not FIPA compliant does not mean that developers do not want that standard, it is simply a developing lack! Maybe one day Aglets will be FIPA compliant....

• **Is FIPA so important?**
  It is difficult to answer to this question, since it depends on a lot of opinions and point of views. FIPA is in general good, but as a most of standards, it could not reflect what developers really wants (usually simplicity and performances). It depends on what you are going to develop if Aglets can be the right choice: if you have to interoperate with a FIPA systems, please choose a FIPA compliant platform (such as JADE). However, please note that there are other platforms which do not adhere to the FIPA standard, such as DIET, while other platforms implements both FIPA and MASIF (such as Grasshopper).

• **Do I need to install Aglets on every machine I want to send an agent to?**
  Yes, or at least you have to write a program which can act as an agent server (i.e., a Tahiti substitute) by your own. The fastest way to get your aglets running is to install Aglets on every host you want to send agents to.

• **Is there another font of documentation? I often hear something about the Aglets book...**
  You can find a few web pages over the Internet that discuss several Aglets related arguments, but please take care that these pages could be out of date (i.e., too old regarding the Aglets version you are running). There is an Aglet book, Programming and deploying Java (TM) Mobile Agents with Aglets, by Danny B. Lange and Mitsuru Oshima, but it is old (it is related to the Aglets 1.0 version), and a lot of things
have changed since it has been published. I don't believe you need the Aglets book to develop agents using Aglets.

- Can Aglets run over a PDA or a smart device?
  Smart devices usually have limited JVMs (except if you install Linux Familiar and Kaffe), thus it is difficult to install and run Aglets as it is. Actually, we are planning on the migration of Tahiti over PDAs, and maybe a FAQ about the use of Aglets and PDAs will be available soon. Here you can find a web project related to the Aglets 1.0.3 version: http://siul02.si.ehu.es/jirgbdat/FACILITIES/PDAs/principal\_ingles.html.

- How many agents can run over the same instance of Tahiti?
  It depends on how powerful is you run-time. Aglets exploits a good threading system, without mapping every agent in a separated thread, but using instead a single thread for multiple agents. This means that the number of agents you can create is not directly dependent on the number of thread your JRE can support. Furthermore, due to the message architecture of Aglets, where a thread is assigned to each message to be processed, the number of supported agents (and their performance) depends on the use of messages that currently running agents are doing.

- I have agents developed with the 1.x version of Aglets, can I run them with the 2.x version?
  So far, there is no knowledge of incompatibility among agents developed with different major versions, even if it is possible that old agents do not run. The first thing to try is to recompile the old agent (if possible) with the new API. If you know or find some incompatibility, please send a message or write a bug report.

  The main difference between the 1.x and the 2.x series, is the use of the Java 2 security mechanism: the old 1.x version did not use it, while the 2.x version do, leading to a more Java 2 compliant application.

- It seems as the ant file is corrupted, what can I do? (only for *nix operating systems)
  Check if the build.xml contains any DOS carriage return characters, and clean the file with the dos2unix command. If it is still not working, try downloading a newer version of Apache Ant from http://www.apache.org.

- I try to start my tahiti server using command agletsd -f myAglets.props, but I got error messages out of environment space, What do I have to do? (only for MS Windows operating systems)
  You have at least two possible ways of extending the memory space: (i) change the size of the argument of the /E: parameter for command.com in the config.sys shell setting. For instance, set of the size of environment variables to 512 bytes, specify:
SHELL=C:\COMMAND.COM  C:\ /P /E:512
// Maximum is 4K:
SHELL=C:\COMMAND.COM /E:4096 /P

You can add this to your config.sys file. If this does not work, try changing
the environment variables of the MS-DOS prompt accessing the memory
section of the Property of the prompt icon.

- **I got an AccessControlException, what do I have to do?**
  This exception is thrown when your code is trying to execute an operation
  for which it has not enough rights (for example, it is trying to open a server-
  socket). Have a look to your policy file, and in the case try using the sample
  shipped with Aglets, that can be installed running the install-home option
  of Ant.

- **Is there a way to directly log-in to Aglets without inserting a user-
  name and a password?**
  Yes. You have to specify the username and the password to use in a proper-
  ties file, and then you have to launch Tahiti specifying the properties file to
  use. First of all, place the username and the password in the file:

  ```
  aglets.owner.name=aglet_key
  aglets.owner.password=aglets
  ```

  where aglet_key and algets are the username and the password existing in
  the keystore; substitute them with the couple you want to use. The launch
  Tahiti specify the option `-f /path/to/the/properties/file`, thus it will
  not prompt you for the username and the password. Please note that this
  option is enabled with the default properties file, `cnf/aglets.props`, but
  you have to explicitly pass the file to the Tahiti command line.

  Please take into account that storing a password in a plain text file is not
  a good security design, thus be careful with permission of such file (i.e.,
  nobody except you should have read/write access to the file).

- **Why the keystore contains [an aglets_key and anonymous] key pair?**
  Aglets requires that each agents has an owner. When you log in to Tahiti,
  you are implicitly saying that all agents created thru the Tahiti user inter-
  face will have “you” as owner. Each aglet will have, as attachment, the keystore
  data to recognize its owner, and this is the reason why you must to log in to
  Tahiti, before you can create any agent.

  Now think at what happens when your platform is receiving an agent from
  an external source, that could be another agent platform. In this case,
  you do not have in your keystore credentials about the owner, since these
  credentials have been stored in the source platform. To solve this problem,
the anonymous keypair is used, and this is the reason why the keystore comes with pre-set keys.

Please note that, even if it is possible to assign permissions on the base of the owner rather than the simple code base, this feature does not seem to work very well.

• Can I disable security checks in Tahiti?
  First of all ask yourself if you really need to run Tahiti without security settings; this is strongly recommended for production machines. Nevertheless, if you are sure you want to do this, edit the aglets.props file and set the property *aglets.secure* to *false*.

• Can I change the logging system?
  Aglets is currently using Log4J; the logger class is determined by the value of the property *aglets.logger.class*, thus you can change the logger simply changing the above property in the aglets.prop file. The Jakarta Log4J class is *org.aglets.log.Log4j.Log4jInitializer*, but you can change it to another, such as *org.aglets.log.console.ConsoleInitializer*, that prints everything to the STDOUT (you should redirection or piping to smartly analyze outputs), or *org.aglets.log.quiet.QuietInitializer* that suppresses the most of the logging output.

• Is there any debugging capability?
  Actually no. I suggest you to use smart printing functions, to understand what is happening to the code. You can try also using the Java DeBugger (jdb), but it could be quite difficult.

• Do I need any special library to compile the source version of Aglets?
  In general no, but you could need a few libraries like Log4j in your classpath. If you have any error, please report it to the mailing lists.

• How can an aglet transport a file from one host to another?
  This is an often asked question over all the aglets mailing lists, therefore please read this point before asking it by yourself. An aglet cannot transport anything that is not a Java serializable object, that means you have to transform your file into a Java serializable object. The kind of the object depends on yourself. For example, if you have to transport a text file, you can read all the file and place its content into a string (i.e., java.lang.String). If the file is a binary one, you have to translate it into a portable object, even a MIME one. Please do not try to migrate a File object, since it will not work! The most efficient way to transform a file into an object depends on what your application must do, and I suggest you to have a look even at the SOAP or any other XML based document form. Finally, please take care that if the file is available by a network filesystem (such as AFP, SMB,
NFS), you do not need to migrate the file at all, but simply to adjust the file name on the destination.

- **Can I use HTTP messaging among aglets?**
  Please note that you can implement any kind of network messaging in Aglets, from standard sockets, to HTTP, SOAP, RMI, etc. But it is on your own to implement such way of communications; you can have a look at the code available at the aglets-net project (see http://sourceforge.net/projects/agletsnet).

- **Is there a way to exchange data among agents?**
  Yes, you have to send messages containing the data you want to exchange, but please take care of the serializability of your objects, since the messaging system allows only serializable messages.

- **Is it possible to run multiple context over the same server? How can I do that?**
  The general answer to this question is yes, even if Tahiti currently does not allow users to create multiple context. Please note that this does not mean that it cannot handle multiple contexts, and in fact you can develop an agent in charge of creating multiple contexts for you. To do this, use the `createContext(..)` method of the `AgletsRuntime` class. When working with multiple context, take care of the URL for dispatching agents to a specific context: place the context name after the machine address, such as `http://machineAddress/contextName`.

- **How can I move an agent among different contexts?**
  You can use the ATP migration protocol, specifying the same address but changing the URL in order to reflect the destination context.

- **Can an Aglet communicate with a Servlet?**
  Yes, take a look at the code below (written by Anjuman Dutta):

```java
public void run(){
    try{
        URL server=new URL("http://localhost:8100/servlet/FirstServlet");
        URLConnection con = server.openConnection();
        con.setDoOutput(true);
        con.setUseCaches(false);
        Calendar rightNow = Calendar.getInstance();

        ObjectOutputSteam request = new ObjectOutputStream(new BufferedOutputStream(
            new ByteArrayOutputStream()));
        StringBuffer d=new StringBuffer("<?xml version="1.0" encoding="UTF-8">
        d.append("<Name>");
        d.append("dude");
    }
```
d.append("</Name>");
String data=d.toString();
String msgtype="xmlFile";
String [] msg=new String[2];
msg[0]=msgtype;
msg[1]=data;
request.writeObject(msg);
request.flush();
request.close();
ObjectInputStream response = null;
Object result = null;
response = new ObjectInputStream(
    new BufferedInputStream(con.getInputStream()));

    // read response back from the server
    result = response.readObject();
}
catch(Exception e) {
    System.out.println(e);
}
}

- Can I develop an agent server on my own? How can I embed the Aglets technology into my application?

You can develop an agent server by your own, and this will allow you also to embed the Aglets technology in your applications. Before posting any question about how to write an agent server, you should carefully have a look at the ServerApp.java source code available with the source code package.

When developing your own server, you should take into account a few issues. There can be authentication problems, that means you could be unable to log in to the server as you are used to do with Tahiti. To overcome this problem, someone has suggested to hardcode the couple username/password in the server source file. Moreover, you can catch some exception due to the unavailability of fonts; if this happens remove the following lines from the Tahiti.initializeGUI() method:

    try {
        Class.forName("sun.awt.PlatformFont"); // for 1.1
    } catch (Exception ex) {
        ex.printStackTrace();
    }

When developing your own server, you have to take care about properties and permissions, thus the new server can access all properties and can act
as a real Tahiti substitute. Furthermore, remember that each agent must belong to one context, that means you have to create a context first, then you can create agents or other contexts. The following piece of code has been written as an example by Gustavo Nucci Franco:

```java
import com.ibm.atp.daemon.*;
import com.ibm.aglet.system.*;
import com.ibm.aglet.*;
import java.net.*;

public class xAgletContext{
    public AgletContext context;
    public int portNumber;

    public xAgletContext(int pn){
        portNumber = pn;
        String [] arg = {"-port", String.valueOf(portNumber)};
        Daemon daemon = Daemon.init(arg);
        AgletRuntime runtime = AgletRuntime.init(arg);
        context = runtime.createAgletContext("");
        daemon.start("aglets");
        context.start();
        context.addContextListener(new CL());
    }

    class CL extends ContextAdapter{
        //You should implement listeners’ events to monitor
        //the life cicle of your aglets here
    }
}
```

If you get a `java.lang.ExceptionInInitializerError` or `java.lang.NullPointerException` related to the `LogInitializer.getCategory(Unknown Source)`, it means that the logging system cannot be loaded and initialized statically. Try this:

```java
String initializerName = System.getProperty("aglets.logger.class",
            "org.aglets.log.quiet.QuietInitializer");
Class.forName(initializerName);
```

that will load the logger, making the exception to disappear.

Another example of a server can be the following:

```java
// usage: java SimpleServer <keystore> <policy> <username> <password> <port>
```
import java.net.*;
import java.util.*;
import com.ibm.aglet.*;
import com.ibm.aglets.*;
import com.ibm.aglets.tahiti.*;
import com.ibm.maf.*;

public class SimpleServer{
    com.ibm.aglet.system.AgletRuntime runtime;
    private String username;
    private String password;
    private String port;
    private String keyStore;
    private String policy;
    AgletContext context;
    MAFAgentSystem maf_system;

    public SimpleServer(String args[]){
        try{
            // get all parameters
            keystore = args[0];
            policy = args[1];
            username =args[2];
            password = args[3];
            port = args[4];
        }
    catch (Exception ex){
            ex.printStackTrace();
        }
    }

    public void setup(){
        Properties props = System.getProperties();
        // Setup properties
        props.put("atp.resolve", "true");
        props.put("atp.useip", "true");
        props.put("maf.port", port);
        props.put("maf.protocol", "atp");
        props.put("java.policy", policy);
        props.put("aglets.keystore.file", keystore);
        props.put("maf.finder.port", "4435");
        props.put("maf.finder.host", "localhost");
        props.put("maf.finder.name", "MAFFinder");
        props.put("aglets.logger.class", "org.aglets.log.console.ConsoleInitializer");
        props.put("agletslogfile", "aglets.log");
        String initializerName = System.getProperty("aglets.logger.class", "org.aglets.log.console.ConsoleInitializer");
    }
try{
    Class.forName(initializerName);
} catch (ClassNotFoundException ex){
    ex.printStackTrace();
}

public void start(){
    this.setup();
    runtime = runtime.init(null);
    runtime.authenticateOwner(username, password);
    maf_system = new MAFAgentSystem_AgletsImpl(runtime);
    String protocol = "atp";
    try{
        MAFAgentSystem.initMAFAgentSystem(maf_system, protocol);
        // use Tahiti classes to initialize
        Tahiti.installFactories();
        Tahiti.installSecurity();
        // create context
        context = runtime.createAgletContext("");
        MAFAgentSystem.startMAFAgentSystem(maf_system, protocol);
        //start context
        context.start();
    } catch (MAFExtendedException ex){
        ex.printStackTrace();
    }
}

public static void main(String[] args){
    SimpleServer simple = new SimpleServer(args);
    simple.start();
}

• Can I use IP addresses instead of DNS names for URLs?
  Yes, and in some situations it is suggested you do that. For example, if
  you are working with machines not registered in a DNS; you should use IP
  addresses instead of host names.

• I can send an agent to another machine but I cannot retract it
  back. Dispatching the agent other the same machine raises a
  RequestRefusedException. How can I solve this?
  It is probably a problem of DNS. Try using IP addresses in the URLs or to
  add the machine name and address to each hosts file.
• I need to fix the security policies of my server, but I don't know how to know the codebase agents are running from.
You can learn the codebase developing a simple agent that executes:

```java
try {
    URL codeBase =
        ((Aglet)this.getProxy().getAgletInfo().getCodeBase();
    System.out.println("codeBase: " + codeBase);
} catch (InvalidAgletException e) {
    System.out.println("InvalidAgletException");
}
```

Please be aware that, if your hostname changes (e.g., change of the network, ISP, etc.), your permissions must be set up again, because your codebase changes accordingly to the hostname. Furthermore, consider that codebase are not interpreted but they are treated literally. This means that if your hostname is `myHost`, using `myHost` or `myHost.myDomain` is not the same, even if the former is the full qualification of the former.

• I checked permissions, but I still got exception related to them.
Try placing permissions also in the security files into the `$HOME/.aglets` directory.

• When I execute agents I got No integrity Check because no security domain is authenticated.
This is a warning message, and you can ignore it. It simply reports that you haven’t set up a security domain.

• Sometimes, running particular agents or dispatching them, I got exception related to the class loading (e.g., `ClassNotFoundException`, `ClassFormatException`, etc.). How can I fix it?
Try adding your library jar to the classpath, even in the Tahiti property. If this does not work, try adding the unjared classes to the public root.

• Can I avoid a few references to be serialized?
If your agent declares a few references as `transient`, then they will never be serialized during the aglet travel. This does not mean that they will be removed by the agent, but simply that they will be “reset” to a null value on the destination, that means you have to check (and in case, recreate) references in the `onCreation(...)` method (or in your mobility listener).

• Can an Aglets wait for a specific message before continuing its execution?
Yes, but it is not very simple. You can deactivate the aglet, waiting for an incoming message and then restarting its execution.
• **When I try to launch my agent I got a ClassNot FoundException.**
   It means that the Aglets runtime cannot find your agent class. First of all, be sure that your classes and packages are stored in the public root, that is usually $AGLETS_HOME/public; if it is still not working, try manually setting your classpath to include your classes, and then restart the server. If it is still not working, try making a jar of your classes and place it in the lib directory of your Aglets installation.

• **If I print information about an aglet proxy, I get something like Aglet [invalid], and the proxy is not working. How can I fix it?**
   You should use the proxy’s id, instead of storing the proxy in a complex data (such as an hash map, a vector or an array), since using data structures to store proxies can invalidate them, since the agent situation can change. The agent and proxy id is unique, thus you can always get the proxy back starting from the id.

• **Can I use static initializers in my agents?**
   You should avoid static initializers, since if your agent migrates, the initializers will not be re-executed. In particular, this can cause problems with transient variables, thus you should absolutely place your initializers in the onCreation(..) method.

• **Is it possible to avoid that deactivated agents are automatically reactivated when Tahiti restarts?**
   Yes, edit the properties file and set the cleanstart parameter to true.

### 5.2 Configuration Files

This chapter contains examples of configuration files, that can help you to check the set-up of your Aglets platform.

#### The aglets.props file

The following is the default aglets.props configuration file shipped with the Aglets platform.

```plaintext
# (mandatory) A path under where aglets is installed. Set on command
# line by agletsd but can be overridden here.
#aglets.home=\aglets\aglets1_2

# (optional) A path to the directory under where ".aglets" directory resides. This is also where your KEYSTORE must be.
# default: $HOME (unix) or \%HOME% (win32)
#user.home=

# (optional) Location of aglets.policy file,
# default: (user.home)/.aglets/security/aglets.policy
```

64
#java.policy=

# (optional) Which protocol to use(atp or rmi)
# default: atp
maf.protocol=atp

# (optional) Port number used by agents server.
# default: 4434
maf.port=4434

# (optional) Host name of Finder used to register/lookup
# the locations of agents.
# default: Not used
maf.finder.host=artemis.trl.ibm.com

# (optional) Port number of Finder used to register/lookup
# the locations of agents.
# default: 4435
maf.finder.port=4435

# (optional) Registry name of the Finder.
# default: MAFFinder
maf.finder.name=MAFFinder

# (optional) verbose output
# default: false
verbose=true

# (optional) Default search path for class files.
# Windows: ';' separated path list
# Unix:  ':' separated path list
# default: (aglets.home)/public
aglets.class.path=

# (optional) Directory which are exported to other aglets servers.
# default: (aglets.home)/public
aglets.public.root=C:\\Aglets\public

# (optional) Aliases used for codebase of aglets.
aglets.public.aliases=
# "tau="/home/tau,\n# "mima="/home/mima

# (optional) If false, every activities of aglets in the server
# will be allowed.
# default: true
aglets.secure=true

# (optional) Class name of an AgletContextListener (Viewer)
# To run server with no UI, set null.
# i.e. "aglets.viewer="
# default: com.ibm.aglets.tahiti.Tahiti
# (ALT: com.ibm.aglets.tahiti.CommandLine)
aglets.viewer=com.ibm.aglets.tahiti.Tahiti
# (optional)
aglets.logfile=aglets.log

# (optional)
# default: false
#aglets.cleanstart=false

# (optional) Comma(,) separated list of URLs(or class names) of aglets
# which should be created just after the server starts.
#aglets.startup=
# examples.hello.HelloAglet,
# atp://yourhost:434/examples.hello.HelloAglet

# (optional) Resolve the domain name of the host by querying DNS server.
# default: false
#atp.resolve=false

# (optional) TCP/IP domain name of the host
#atp.domain=calivera.com

# (optional) Set server's hostname to "localhost". This is useful if
# the host does not have any network adapter.
# default: false
#atp.offline=true

# (optional) Authenticate other servers when the server try to communicate
# each other. Servers form security domains.
# default: false
#atp.authentication=false

# (optional) Use secure random seed generation which is provided by JDK.
# If this is set to false, aglet server uses a proprietary one,
# which is unsecure but fast.
# default: true
#atp.secureseed=true

# (optional) User servers ip address in server URL instead of
# logical name. This is useful if you don't have a DNS entry.
# default: false
#atp.useip=true

# User ID for authorization. This key must exist in your keystore.
# See keytool documentation for info on creating entry. (genkey)
aglets.owner.name=aglet_key

# Password for above user ID. Must be same as entered as the key password
# used with keytool.
aglets.owner.password=aglets

# Keystore password. Same as used with keytool.
aglets.keystore.password=aglets

# Logger class for ASDK.
The agletslog.xml file

The following is the default agletslog.xml configuration file shipped with the Aglets platform

```xml
<?xml version="1.0" encoding="UTF-8" ?>
<!DOCTYPE log4j:configuration SYSTEM "log4j.dtd">

<log4j:configuration>
  <!-- Layout does not use location info and is faster. -->
  <layout class="org.apache.log4j.PatternLayout">
    <param name="ConversionPattern" value="%d{ABSOLUTE} %5p [%t] %c{2} - %m%n"/>
  </layout>

  <appender name="CONSOLE" class="org.apache.log4j.ConsoleAppender">
    <layout class="org.apache.log4j.PatternLayout">
      <param name="ConversionPattern" value="%d{ABSOLUTE} %5p [%t] %c{2} (\%f:\%l) - %m%n"/>
    </layout>
  </appender>

  <category name="org" additivity="false">
    <priority value="debug" />
    <appender-ref ref="CONSOLE" />
  </category>

  <category name="com" additivity="false">
    <priority value="debug" />
    <appender-ref ref="CONSOLE" />
  </category>

  <!-- Must be last element!! -->
  <root>
    <priority value="debug" />
    <appender-ref ref="CONSOLE" />
  </root>
</log4j:configuration>
```
Chapter 6

The IBM Public License - version 1.0

THE ACCOMPANYING PROGRAM IS PROVIDED UNDER THE TERMS OF THIS IBM PUBLIC LICENSE ("AGREEMENT"). ANY USE, REPRODUCTION OR DISTRIBUTION OF THE PROGRAM CONSTITUTES RECIPIENT'S ACCEPTANCE OF THIS AGREEMENT.

DEFINITIONS

"Contribution" means:

1. in the case of International Business Machines Corporation ("IBM"), the Original Program, and 2. in the case of each Contributor, 1. changes to the Program, and 2. additions to the Program; where such changes and/or additions to the Program originate from and are distributed by that particular Contributor. A Contribution ‘originate’ from a Contributor if it was added to the Program by such Contributor itself or anyone acting on such Contributor’s behalf. Contributions do not include additions to the Program which: (i) are separate modules of software distributed in conjunction with the Program under their own license agreement, and (ii) are not derivative works of the Program.

"Contributor" means IBM and any other entity that distributes the Program.

"Licensed Patents" mean patent claims licensable by a Contributor which are necessarily infringed by the use or sale of its Contribution alone or when combined with the Program.

"Original Program" means the original version of the software accompanying this Agreement as released by IBM, including source code, object code and documentation, if any.

"Program" means the Original Program and Contributions.
"Recipient" means anyone who receives the Program under this Agreement, including all Contributors.

**GRANT OF RIGHTS**

1. Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive, worldwide, royalty-free copyright license to reproduce, prepare derivative works of, publicly display, publicly perform, distribute and sublicense the Contribution of such Contributor, if any, and such derivative works, in source code and object code form. 2. Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive, worldwide, royalty-free patent license under Licensed Patents to make, use, sell, offer to sell, import and otherwise transfer the Contribution of such Contributor, if any, in source code and object code form. This patent license shall apply to the combination of the Contribution and the Program if, at the time the Contribution is added by the Contributor, such addition of the Contribution causes such combination to be covered by the Licensed Patents. The patent license shall not apply to any other combinations which include the Contribution. No hardware per se is licensed hereunder. 3. Recipient understands that although each Contributor grants the licenses to its Contributions set forth herein, no assurances are provided by any Contributor that the Program does not infringe the patent or other intellectual property rights of any other entity. Each Contributor disclaims any liability to Recipient for claims brought by any other entity based on infringement of intellectual property rights or otherwise. As a condition to exercising the rights and licenses granted hereunder, each Recipient hereby assumes sole responsibility to secure any other intellectual property rights needed, if any. For example, if a third party patent license is required to allow Recipient to distribute the Program, it is Recipient's responsibility to acquire that license before distributing the Program. 4. Each Contributor represents that to its knowledge it has sufficient copyright rights in its Contribution, if any, to grant the copyright license set forth in this Agreement.

**REQUIREMENTS**

A Contributor may choose to distribute the Program in object code form under its own license agreement, provided that:

1. it complies with the terms and conditions of this Agreement; and 2. its license agreement: 1. effectively disclaims on behalf of all Contributors all warranties and conditions, express and implied, including warranties or conditions of title and non-infringement, and implied warranties or conditions of merchantability and fitness for a particular purpose; 2. effectively excludes on behalf of all Contributors all liability for damages, including
direct, indirect, special, incidental and consequential damages, such as lost
profits; 3. states that any provisions which differ from this Agreement are
offered by that Contributor alone and not by any other party; and 4. states
that source code for the Program is available from such Contributor, and
informs licensees how to obtain it in a reasonable manner on or through a
medium customarily used for software exchange.

When the Program is made available in source code form:
1. it must be made available under this Agreement; and 2. a copy of this
Agreement must be included with each copy of the Program.

Each Contributor must include the following in a conspicuous location
in the Program:
Copyright (C) 1996, 1999 International Business Machines Corporation
and others. All Rights Reserved.

In addition, each Contributor must identify itself as the originator of its
Contribution, if any, in a manner that reasonably allows subsequent Recipi-
ents to identify the originator of the Contribution.

COMMERCIAL DISTRIBUTION

Commercial distributors of software may accept certain responsibilities with
respect to end users, business partners and the like. While this license is
intended to facilitate the commercial use of the Program, the Contributor
who includes the Program in a commercial product offering should do so in
a manner which does not create potential liability for other Contributors.
Therefore, if a Contributor includes the Program in a commercial product
offering, such Contributor ("Commercial Contributor") hereby agrees to de-
defend and indemnify every other Contributor ("Indemnified Contributor")
against any losses, damages and costs (collectively "Losses") arising from
claims, lawsuits and other legal actions brought by a third party against
the Indemnified Contributor to the extent caused by the acts or omissions
of such Commercial Contributor in connection with its distribution of the
Program in a commercial product offering. The obligations in this section do
not apply to any claims or Losses relating to any actual or alleged intellec-
tual property infringement. In order to qualify, an Indemnified Contributor
must: a) promptly notify the Commercial Contributor in writing of such
claim, and b) allow the Commercial Contributor to control, and cooperate
with the Commercial Contributor in, the defense and any related settlement
negotiations. The Indemnified Contributor may participate in any such claim
at its own expense.

For example, a Contributor might include the Program in a commercial
product offering, Product X. That Contributor is then a Commercial Con-
tributor. If that Commercial Contributor then makes performance claims,
or offers warranties related to Product X, those performance claims and war-
ranties are such Commercial Contributor’s responsibility alone. Under this section, the Commercial Contributor would have to defend claims against the other Contributors related to those performance claims and warranties, and if a court requires any other Contributor to pay any damages as a result, the Commercial Contributor must pay those damages.

NO WARRANTY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, EITHER EXPRESS OR IMPLIED INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OR CONDITIONS OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Each Recipient is solely responsible for determining the appropriateness of using and distributing the Program and assumes all risks associated with its exercise of rights under this Agreement, including but not limited to the risks and costs of program errors, compliance with applicable laws, damage to or loss of data, programs or equipment, and unavailability or interruption of operations.

DISCLAIMER OF LIABILITY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT NOR ANY CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY LIABILITY FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION LOST PROFITS), HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OR DISTRIBUTION OF THE PROGRAM OR THE EXERCISE OF ANY RIGHTS GRANTED HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

GENERAL

If any provision of this Agreement is invalid or unenforceable under applicable law, it shall not affect the validity or enforceability of the remainder of the terms of this Agreement, and without further action by the parties hereto, such provision shall be reformed to the minimum extent necessary to make such provision valid and enforceable.

If Recipient institutes patent litigation against a Contributor with respect to a patent applicable to software (including a cross-claim or counterclaim in
a lawsuit), then any patent licenses granted by that Contributor to such Recipient under this Agreement shall terminate as of the date such litigation is filed. In addition, if Recipient institutes patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Program itself (excluding combinations of the Program with other software or hardware) infringes such Recipient’s patent(s), then such Recipient’s rights granted under Section 2(b) shall terminate as of the date such litigation is filed.

All Recipient’s rights under this Agreement shall terminate if it fails to comply with any of the material terms or conditions of this Agreement and does not cure such failure in a reasonable period of time after becoming aware of such noncompliance. If all Recipient’s rights under this Agreement terminate, Recipient agrees to cease use and distribution of the Program as soon as reasonably practicable. However, Recipient’s obligations under this Agreement and any licenses granted by Recipient relating to the Program shall continue and survive.

IBM may publish new versions (including revisions) of this Agreement from time to time. Each new version of the Agreement will be given a distinguishing version number. The Program (including Contributions) may always be distributed subject to the version of the Agreement under which it was received. In addition, after a new version of the Agreement is published, Contributor may elect to distribute the Program (including its Contributions) under the new version. No one other than IBM has the right to modify this Agreement. Except as expressly stated in Sections 2(a) and 2(b) above, Recipient receives no rights or licenses to the intellectual property of any Contributor under this Agreement, whether expressly, by implication, estoppel or otherwise. All rights in the Program not expressly granted under this Agreement are reserved.

This Agreement is governed by the laws of the State of New York and the intellectual property laws of the United States of America. No party to this Agreement will bring a legal action under this Agreement more than one year after the cause of action arose. Each party waives its rights to a jury trial in any resulting litigation.